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scanned and the significant words added to an
index.
To simplify the terminology, I will refer to all the
web searching programs as “spiders”. (It takes
less space and is easier to type.) These spiders
are programs designed to find web addresses
(URL’s) and to download the pages. Some also
do the indexing of the words on the page.
However, Google uses a separate indexing
program and stores the downloaded pages for
future reference. Now if a single spider were
being used to locate and download pages, the
task would really be impossible. Sergey Brin and
Lawrence Page, the originators of Google,
published a paper while they were graduate
students at Stanford that utilized three spiders.
Each spider kept about 300 connections open
simultaneously. With four spiders they could
download about 600 pages per second. This
paper referred to the prototype that became the
commercial Google enterprise. Even with the
prototype system they were able to download
and index 24 million pages in a week. Their
current methodology is proprietary and so is not
public,
but it is probably a significant
improvement over their prototype system.
We can use the original Google system as a
model of what could be used by search engines
to prepare the index and database of web pages
that you access when you send a query. The first
step is to send a list of URLs to the spider to
download. This is done by a server that maintains
a list of URLs. The spider will download pages
and also follow any hyperlinks to other pages.
Addresses of pages that were linked to the
original search list are also sent back to the server
to be checked to see if they were already on the
list. If not, they are added to the URL lists. Not
every spider uses a URL server. The spider will
continue crawling the web until it reaches a dead
end or a page with no further links.
As I mentioned earlier, a spider isn’t just working
with one page, but has hundreds of connections
open to different pages. Given that there are
billions of pages on the Web, even with
thousands of spiders collecting information, only
a small fraction of the entire web is scanned.
Some web sites, such as those with news or
rapidly changing information are visited hourly.
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Every spider has a re-visitation policy that
determines how frequently a page will be revisited
and checked for changes.
There is another general policy that is usually
programmed into these spiders. That is called the
“politeness” policy. This is used to prevent the
overloading of web sites. After all, there is a
finite limit to bandwidth and it would be possible
to overwhelm a web site with visits from multiple
spiders in a short period of time. This policy
provides for an interval of time to elapse between
accesses by a spider. This time interval seems
to vary from 20 seconds to 3-4 minutes. This
would be the case where multiple pages need
to be downloaded from a single server. Revisiting
indexed and stored web sites occurs at less
frequent intervals.
However,
even this politeness policy is
sometimes inadequate.
Frequent visits by
spiders may result in complaints being sent back
to the owner of the spider. So it is also possible to
enter code on a web page which asks the spider
to not access or download a page or pages. This
can be done by the addition of meta tags in the
page header or by a robots.txt file placed in the
root directory for the web site. This is especially
appropriate for game pages. These pages use a
dynamic format that changes when pages are
viewed or links are followed. When a spider
downloads these pages the game program may
respond as if a very high-speed player were
logged on. This can create problems for the
program and may result in crashing the game
server. So we now have the robot exclusion
protocol being used by owners of web pages that
do not want their pages included in the search
engine indexing.
In the original Google system the web pages
were sent to another program referred to as the
indexer. This program sorts through every word
on the page and stores them in a database.
The exceptions are the simple words such as a,
an, the. However, simply entering the words into a
database is not sufficient. They have to be
identified to the particular page from which they
came, the location on that page and a relative
ranking in importance. The frequency with which
they appear on the page as well as the position on
the page may be used in determining the weight
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or relative rank. Words in the title or near the
top of the page may be ranked as more
important. So the storage of the words
include the URL, and a calculated weight in an
encoded format.

marks must appear as a phrase.
Followed By - one of the terms must be followed
by the other.
Near - one of the terms must be within a
specified number of words of the other.

The word database is then indexed to speed the
retrieval of the information. This is usually done
by the building of a Hash Table. Hashing evens
out the alphabetical sections so that it takes no
longer to find a “z” than it does a more popular
letter like “m”. It also separates the index from
the actual entry for the word. This improves the
efficiency of the storage of this information. The
indexing and the Hash Table also speed the
overall retrieval of the information. The complete
web page is also stored in a separate location.
Once the indexing process is completed, the
information is available for your query.

Generally, search engines can use these Boolean
operators to provide results more closely aligned
to the topic you are trying to locate.

Given the size of the web and the continuing
changes to web pages, the spider’s search is
never ending. It may also be one where we will
never have every page indexed. One other
aspect of the size of the web and the time
required for the crawling process is that broken
links will always occur. If a page is not re-visited
frequently, it may still be in the index and the
database long after it has been removed from
its server. Another situation may be where the
URL has changed and the new location has not
yet been crawled. So, the process is not perfect
by any means.
The other aspect of searching the web is the
design of the query you want to submit to a
search engine. As I’m sure you know, you can
simply list a few keywords in the search engine
and hope you will get a useful result. Many
times you will also get results that have no
relationship to the information you are seeking. In
some of these cases, you need to try the
advanced search or learn to use Boolean
operators. Those most frequently used are:

Like everything else related to computers, web
indexing and searching are not static
technologies. The search engine companies are
researching “natural language” queries such as
those handled by “Ask Jeeves”. Currently, these
queries can accommodate only relatively simple
phrases. However, there is heavy competition to
develop an engine that can work with much more
complex queries. Another area that is being
pursued is “concept-based” searching. This
would use a form of statistical analysis to
determine if the page fit your query. And, as you
may have read, Google has plans to put the
content of the world’s libraries on the web.
Just imagine what it would be like if we didn’t
have these search engines to help us find
information on the web. So good searching and I
hope you find what you are looking for.
Dr. Lewis is a former university & medical school
professor. He has been working with personal
computers for more than thirty years. He can be
reached via e-mail: bwsail at yahoo.com.

Lindows seems to be showing up at the oddest places.

AND - all the terms joined by “AND” must appear
in the pages or documents.
OR - at least one of the terms joined by “OR”
must appear in the pages or documents.
NOT - the term or terms following “NOT” must
appear.
Quotation marks - Words between quotation
http://www.caeug.net
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Minutes of CAEUG Meeting September 17, 2005
Mike Goldberg called the meeting to order at 9:45 am.
There were 23 in members in attendance and no visitors.
The Financial Report was presented by Lynn Johnson. Starting Balance $3,648.39, Income
$232.00,Expenses $31.72, New Ending Balance $3,848.67.
Mike recognized Kathy Groce and John Spizzirri for putting the Newsletter and the Lamp Post article
together so quickly. Kathy asked that any corrections to the newsletter be sent to her via email.
Old Business:
Volunteers for the next COD show on September 25 were discussed. Anyone willing to represent the
club at the show can get a free admission. The show lets two members in free and the club will
reimburse two other members who work at ourtable. The reimbursement is given at the next monthly
meeting.
New Business:
There is a Chicago Computer Society event today and some of ourmembers are attending.
The CAEUG Web Site is available with no log in required. Some members seem to be having problems
accessing the site, so John will investigate.
Kathy will do a presentation next month on how she puts the newsletter together using Adobe
PageMaker and Acrobat.
There was discussion on the Following topics:
·Quicken Medical
·Converting filesfrom WordPerfect 6.0 to Word
·Google earth
·Digital camerasand picture storage
·A capacitorproblem on Mother Boards and in other electronic devices.
Raffle items included a Wintv card, WordperfectBooks, and Photosuite.
The presentation was made by Nancy Kinzie on computerized sewing.
The meeting was adjourned at 11:42.
Respectfully submitted,
Al Skwara

☺
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CD of the Month Contents October 2005

AngelWriter - Free text editor that allows formatted text, graphics and tables
ARI October Newsletter
ChaosManager A compact organizer includes an appointment/to-do manager, a calendar,
contacts, a notebook, & more
ChinesePractice A flash card program for learning Chinese
CISSmartCD-MenuCreator CD-Menu Creator
CloudmarkAnti-FraudToolbar An anti-fraud toolbar for IE
ContactMatrix A powerful “anything” organizer
Copy2Clip Copy file names from Windows Explorer
CursorUS A simple utility that allows continuous mouse movement (move mouse right
off screen - it appears on left)
dotBookmark Synchronize bookmarks between programs via the Internet
DVYGUN A desktop search tool that indexes the content of your hard drive(s)
Firefox107 Latest upgade to Firefox
Firefox15Beta The beta for the next generation of Firefox
ForceDelete Forces the delete of a file Windows won’t let you delete at next boot up
FormLetterMachine - A template creator for letters or e-mail
FreeDOS A DOS that Microsoft did not write
FreshDownload A download manager that Microsoft forgot - use with IE
GameCopier A CD backup (copy) program - Trial
GameScanTools Tools to determine if a CD/DVD is copy protected and what the protection is
GoogleEarth View global imagery available on Google
HTTrackWebSiteCopier A program to backup a Web site to your hard drive
KAlert An add-on for Microsoft Outlook 2003 that can extend the Outlook reminder
function
KlikSafe Allows changing IE security levels with just a click
MapleXP Keep track of how much time you are spending on your computer
MyBackup - Backup program
MyFavorites - Bookmark keeper program
MyWeekly Simple to do list program
NetPicker Save snippets of Web information by dragging it from your browser to a target icon
Newzie RSS, Atom feeds, and OPML files reader
OldTimeRadio Various old radio MP3s
PageBreeze - Powerful HTML Editor which has both visual (WYSIWYG) and HTML tag modes
PCInspectorFileRecovery - Data recovery program for lost files even when the boot sector has
been damaged or erased
PCPowerOptimizerLite Access common system settings to optimize your PC
PixRecovery - Restores the corrupted image files and saves as Windows Bitmap
SmartMP3Renamer - A program designed to automatically rename and tag mp3 album
Trace Utility gives you a security risk rating on the presence of hidden information in your
Microsoft documents
TrilogyEC A secure Instant Messenger with 256 bit encryption
TrustToolbar - Link to toolbar that works with MS IE to help you avoid phishing attacks
VAMPMediaCenter - A multimedia suite with many functions
virtualPhotographer - An Adobe Photoshop plug-in that enables you to apply a variety of color filter
effects
WPanorama - An image viewer specially designed for panorama pictures
WPChanger - Program that cycles through wallpaper you select
WYSIWYGWebBuilder WYSIWYG Web page builder that allows you to create a standard
Web page without HTML coding
ZipGenius A zip program that supports 21 types of compression and file encoding formats
http://www.caeug.net
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Lamp Post 67
By John Spizzirri
October 10, 2005
I would like to thank the members that have purchased products from Amazon.com
( http://www.amazon.com ) by going through the CAEUG ( http://www.caeug.net ) Web site. The
club has generated $3.50 in income thus far. As a reminder, there are ‘featured’ products on our Web
site and a generic Amazon.com icon near the bottom of the page. By clicking on any of these icons
our club is identified as the referring site and if a purchase is made the club gets a small percentage
of the purchase price depending on what is purchased. The percentage varies based on the type of
item. $3.50 might not sound like much but it is money that the club would not get when members buy
things that they want from other retailers. Amazon pricing is competitive with many other sites. Keep
up the good work.
Opera ( http://www.opera.com ) has started to compete with Firefox
( http://www.mozilla.org ) by removing the advertising from its free product
( http://www.theregister.co.uk/2005/09/30/opera_strategy/ ). The new version is on the CD of the
Month (October).
MS has made an agreement with the government of Nigeria to fight Internet crime (spam, spyware,
financial scams, i.e. the 419 financial scam, etc.). I found that report at
http://apnews1.iwon.com/article/20051015/D8D85ER01.html . It claims that a statement is on the
MS Web site. I could not find any statement on the site. I did find that President Olusegun Obasanjo’s
son Dare works for MS in the U.S. as a programmer
( http://en.wikipedia.org/wiki/Dare_Obasanjo ). I find it troubling that MS would deal with President
Olusegun Obasanjo ( http://en.wikipedia.org/wiki/Olusegun_Obasanjo ). He is significantly better
than his predecessors in the area of human rights, but has recently admitted that torture, rape, and death
have occurred to people in police custody
( http://www.state.gov/g/drl/rls/hrrpt/2003/27743.htm ). Also, some of the northern states
(provinces) have instituted Muslim sharia law. Under this law, people convicted of a crime (?) can be
sentenced to death by hanging or stoning, limb amputations, or flogging. Crimes include drinking
alcohol, adultery, and giving birth outside of wedlock
( http://web.amnesty.org/report2003/nga-summary-eng ). I will grant that the 419 scam is a
problem in the U.S.
( http://www.secretservice.gov/alert419.shtml & http://en.wikipedia.org/wiki/Advance_fee_fraud ), but I
doubt that MS will have any clout to curb it. The 419 scam seems to be a government enforcement
problem. The current regime in Nigeria seems to be better than all the regimes that have come before
it in modern times. Even so, any crackpot with a gun or machete can kill the Nigerian president and take
over. Nigeria is gas and oil rich
( http://www.cia.gov/cia/publications/factbook/geos/ni.html ). You may recall the first conflict
over oil in the 1960’s. The people in Biafra, a section of Nigeria, were starved by the central government
to gain control over the oil reserves there. (Biafran oil, as it was pumped out of the ground in those days,
was so pure and clean that it could be used in diesel vehicles as fuel without refinement.) Every dictator
since has showered the wealth on themselves and left the people uneducated and poor. When I think
of this agreement, Arthur Neville Chamberlain comes to mind
( http://www.bbc.co.uk/history/historic_figures/chamberlain_arthur_neville.shtml ).
ZDNet, Slashdot, and others reported that Oracle Corporation ( http://www.oracle.com/ ) purchased
Innobase Oy, the maker of InnoDB ( http://www.innodb.com/ ). InnoDB is a program that provides an
interface to MySQL ( http://www.mysql.com/ ). This is a peculiar situation. Oracle has indicated it’s
(con't on page 7)
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opposition to Open Source Software (OSS http://www.opensource.org/ http://www.w3.org/Status ).
Now it buys an OSS company. Innobase is a ‘for profit’ company that licenses InnoDB for corporate use
as does MySQL. Has Oracle seen the light of open source? Hardly! Oracle has been forced to lower
it’s prices due to OSS competition. Oracle is looking to regain market share. The acquisition articles are
at http://news.zdnet.com/2100-3513_22-5892632.html?tag=nl.e550 and
http://developers.slashdot.org/article.pl?sid=05/10/07/2021211&from=rss .
Firefox is not picking up as many downloads as it did earlier this year. Some pundits are saying that
Mozilla is running out of Microsoft ( MS http://www.microsoft.com ) haters. I don’t think it is due to a
lack of MS haters but a fear of the unknown. Those that know Internet Explorer (IE) are fearful that learning
Firefox will be difficult. If any our members have this fear, please be assured that Firefox is just as easy
as IE and has many features that IE does not have.
I will now provide reasons to switch to Firefox and detail how to install it.
1. Internet
Explorer (IE) is the most used browser in the world. Over 90% of all PC users use IE.
That fact makes it a target for crackers ( black hat hackers
http://searchsecurity.techtarget.com/sDefinition/0,,sid14_gci550815,00.html ).
2. IE is integrated into the Windows operating system (OS). During the MS anti-trust trial, MS
stated that IE could not be removed from Windows because it was NOT a separate product
from the OS.
3. ActiveX, VBScript and browser helper objects (BHOs) make IE do some things that can
enhance the user’s experience with the Internet but at the same time can be used by crackers to
do bad things.
4. IE was written ten years ago. The ‘browser wars’ (adding features) were hot back then.
Netscape was making money giving their product away to users. They charged for commercial
use. Netscape was based on the Mozilla browser. Netscape was safer to use than IE because
Netscape rigidly stuck to the specifications for browsers set forth by W3C
( http://www.w3.org/ ). MS tried to enhance IE so they could charge for it. The enhancements
created security problems. Integration into Windows also created security problems. When AOL
bought Netscape, development virtually stopped. With no competitive development, MS
stopped development and started to provide tweaks and graphical user interface (GUI)
enhancements. Mozilla was years away from a usable product.
5. As I have reported in these pages, MS does not fix security problems promptly. Sometimes months
go by before a reported security hole is fixed.
6. IE is noticeably slower to display Web pages than Firefox.
7. There are no tabs. Once you have used a tabbed browser, you will know what I am talking about.
8. There is no integrated pop-up stopper, ad blocker, or download manager.
9. IE is really big.
10. IE cannot be used on Linux or BSD OSs.
11. Users are locked into Windows XP. Security patches are no longer supplied to users of IE that are
not using XP. I guess you will have to upgrade.
12. IE cannot be uninstalled. DO NOT EVEN TRY IT.
Reasons to stay with IE
1. Some Web sites will not work or load when using Firefox. You can always open IE for those
instances, then go back to Firefox. The most notable site that demands IE, is Windows Update.
2. The Firefox program load more slowly than IE. Remember, IE is integrated into Windows so when
Windows loads, parts of IE get preloaded.
3. IE add-ins do not work in Firefox. In many cases Firefox has comparable add-ins.
4. You may want to wait. MS has promised many of the Firefox features in the next version of IE. I don’t
know if you will be forced to upgrade to Windows Vista to get the new IE.
(con't on page 8)
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How to install Firefox
1. Get the Basic CD or the month or download the installation program from
http://www.mozilla.org/products/firefox/ . It is about 4.7 MB in size. Save the file to the desktop
or a folder that you can locate later.
2. If you have a previous version of Firefox or Firebird, uninstall it. I have skipped this step without
any trouble but it is better to be safe than sorry.
3. Double click the installation file or start -> run that file.
4. Install add-ins that you want by going to http://update.mozilla.org/extensions/ . Get just the
ones that you have used on IE. There are over 400, so don’t go overboard.
5. If you do not like the look of Firefox, click Tools -> Themes. This allows you to customize the
look of Firefox.
6. Install plug-ins like Adobe Acrobat Reader, Apple Quicktime, Macromedia Flash Player, RealPlayer,
and Sun Java. See http://plugindoc.mozdev.org/windows.html for a list of plug-ins.
7. Configure Firefox using Tools -> Options menu and View -> Toolbars menu.
8. If you use RoboForm in IE, get it for Firefox at
http://www.roboform.net/dist/AiRoboForm-Netscape-Adapter.exe .
9. When you start Firefox, it will ask if you want to make it your default browser. This means that
when you click on an htm or HTML document, Firefox will open to display it. It will ask every
time you open it until you check the box that says don’t ask anymore or you select Firefox
as your default browser. Once selected as the default, IE will ask if you want it to be your
default browser.
10. Have fun with the new toy.
Peter Tippett, creator of Norton Anti-Virus ( http://www.symantec.com/ ), has accused the Department
of Homeland Security (DHS http://www.dhs.gov/dhspublic/ ) of a lack of leadership in electronic
security. The Register reported the story at
http://www.theregister.co.uk/2005/10/13/us_cybersecurity_analysis/ .
Our newsletter editor, Kathy Groce, had
an adventure in Hampshire, Illinois,
recently. She went soaring at Sky Soaring
Hampshire
( http://www.skysoaring.com/ ).

Great Midwest Computer Show ©
College of Dupage
Main Arena of Physical Education Building
Corner of Park Blvd & College Road, Glen
Ellyn, IL
9:30 A.M. to 3:00 P.M.
FREEPARKING
Admission - $7.00
Kids 12 and under FREE
http://www.greatmidwestcomputershow.com

E-mail address:
info@greatmidwestcomputershow.com
2005 dates
COD October 30, November 20,
December 18
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CAEUG OFFICERS & CHAIRPERSONS
President
V.P. (Programs)
Secretary (& donuts)
Treasurer
Newsletter Editor
Membership Chairperson
& Circulation Manager
CAEUG COD Coordinator
& Publicity
Software Reviewer
Webmaster
& Technical Consultant
Coffee Service
Picnic Chairpersons

Mike Goldberg
Frank Braman
Dean Holste
L. Johnson
Kathy Groce
Pete Nicchia
TerryMoye
Brian Noon

Reminder: You'll get better,
faster service if you use
CAEUG in the subject of
your e-mail.

John St. Clair
Joan Thompson
Mike Goldberg
Roger Kinzie

MEMBERS HELPLINE

ABOUT THE NEWSLETTER:
This printed version of our newsletter was laid out
using Adobe's Pagemaker Version 7.0 for Windows.
The opinions expressed in this newsletter are not
necessarily those of the CAEUG Officers, members or other
contributors. CAEUG, its officers, newsletter editor, authors
or contributors are not liable in any way for any damages,
lost profits, lost savings, or other incidental or consequential
damage arising from the use of the information provided herein.
Every reasonable effort has been made to confirm the accuracy
of the contents of this newletter, but that accuracy is not
guaranteed.
Permission is granted to reproduce any or all parts
of this newsletter for personal use. Also granted is permission
to reproduce for public ation any part of this newsletter provided
that a copy of the publication is mailed to CAEUG, immediately
following publication and CAEUG is given credit.
The CAEUG newsletter is published eleven times
annually. Contributions by members are encouraged
and will be gratefully acknowledged in the newsletter. We have
a policy of exchanging newsletters with other users groups
across the nation. Several CAEUG member articles have
already been picked up and reprinted.

Beginner's SIG
Ask questions and discuss computer
experiences with this group.
Such as:
1. New to Computers? (basic topics)
2. How to use the Web or download
information
3. How to install hardware/software
4. Discuss how to troubleshoot hardware
conflicts, learn boot up emergency tricks
5. What do you want to know??
SIG meets before regular meeting from
9:05 to 9:45

Any member with a specific expertise can
volunteer to be on the Members Helpline.
Beginner Helpline . . . . . . . . . . . Billy Douglas
Beginner hardware problems . . . Dick Fergus
QuickBooks, Turbo Tax, IBM Lotus, MS Excel,
Corel's Quattro Pro . . . . . . . . . . . Terry Moye
Hardware problems, Win 9x, 2K, XP & Linux . .
. . . . . . . . . . . . . . . . . . . . . . . . . John Spizzirri

CD OF THE MONTH FORMAT: Is now available in two (2) flavors.
The Basic CD will be packed with the standard items,
while the CD of the Month will have NEW and updated
items.
NEW Money Saving Offer for CD of the Month
Pre Order + Prepay = SAVE $$
The club will offer the CD of the Month on a pre order,
prepaid basis. The charge will be $70.00 a year for 9
months. This is $20 annual savings over buying them for
$9 each month. Lynn Johnson, the treasurer, will keep
track of anyone placing a 9-month order.
MAIL Request - There will be a $2.00 mailing charge per CD

Membership Costs.....
Individual
Family
Corporate
Associate

http://www.caeug.net

First Yr.
$25.00
$30.00
$30.00
$20.00

Renewal
$20.00
$25.00
$25.00
$15.00

9

CAEUG
P. O. Box 2727
Glen Ellyn, IL 60138

FIRST CLASS MAIL

Meeting place and date information:
The next REGULAR meeting will be held at the Glenside Public Library in Glendale Heights
starting 9:45am on Saturday October 22
The library is located. Please park at the West side of the lot, away from the building. Thank you.
The meeting(s) are not library sponsored and all inquiries should be directed to Mike Goldberg at
MikeGold60137@yahoo.com. Individuals with disabilities who plan to attend this program and who
require certain accommodations in order to observe and/or participate in the program are requested
to contact CAEUG president, Mike Goldberg at MikeGold60137@yahoo.com, at least five (5) days prior
to the program, so that reasonable accommodation can be made for them.
CONFIRMED Future Meeting dates for 2005 at Glenside Public Library:
October 22, December 3

October 22nd presenter will be Kathy Groce How the ARI is created. An interesting

program that will demonstrate Adobe Pagemaker 7.0, Adobe Acrobat 5.0
December 3rd presentor will be our own Tom Anzalone. Tom has a presentation called
“Linux: The Other Operating System”
CAEUG website has a new home.
Remember to change your bookmark to the new address at
http://www.caeug.net

